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Introduction

Welcome to Cadent monitorLite!!

I want to personally welcome you to Cadent monitorLite: a system utility for monitoring 
processes/applications running on your system using a graphical rather than the traditional 
list-based view.  I hope you find it both useful and educational.

Author of monitorLite and this Documentation (who am I?)

The Cadent monitorLite utility and this documentation was written by me, Doug Oucharek, for 
Cadent Computing Inc.  I’ve been working in the embedded/real time computing world for 
over 20 years now, much of that time as a contractor working for over 15 companies (and 
counting).  My background plays a significant role in why this utility was developed as it is.

Approach to Documentation

When I first started working in the high tech industry, there was a huge push to write all 
documentation in the third person.  The use of the word “I” was strictly forbidden.  As you can 
see, I’m not following that paradigm.  

In this day and age of blogging, I see communication becoming more personal and directed.  
I’ve decided to write this user manual much as I would describe this software in a blog.  I 
hope this style makes for a more interesting, and less dry, read.  

By the way, I am Canadian so I tend to use the British spelling for words like “colour” and 
“behaviour”.  These are not spelling mistakes (though this word processor seems to thinks 
so), they are just a different “flavour” to the varied English language.

Did you know?
Watch for boxes like this where I put interesting bits of information relating to process 
information in MacOS X and Unixes in general.



What monitorLite Is

Description

As introduced in the last section, Cadent monitorLite (hereafter just referred to as 
“monitorLite”) is a utility for monitoring processes/applications running on your system.  On 
MacOS X today, you already have a utility for doing this called “Activity Monitor”.  Many may 
ask: “Why would I want to pay for a utility to do what I already get for free from Apple?” Well, 
here is what I see as the extra “features” monitorLite provides which justify its usefulness (and 
cost):

• Represents the process/application information as a hierarchical graph rather than a 
flat list.  This more closely represents this information as it really works and, therefore, 
does a better job of educating.

• Was written to use much less CPU than Activity Monitor does.

• Provides a powerful “snapshot” feature allowing you see what is, and is not, running 
on your system now relative to a previous point in time.  Very useful to track activity.

• Has a search box to quickly find processes you are looking for.

• Provides a slimed-down view of what files/internet connections an application has 
open: Activity Monitor shows everything from directory trees to files to all of the 
dynamic libraries used by the application.  Most users are only interested in the data 
files open and what connections to the internet an application has.  This view is also 
represented as a hierarchical graph.

• Can export these graphical views to the graphviz DOT file format.  This makes it 
available to other applications which support the DOT format like graphviz (http://
www.graphviz.org) and the Omni Group’s OmniGraffe version 5 (http://
www.omnigroup.com/applications/omnigraffle/ ).  These applications allow you to 
annotate your graph, to print it off, etc.

• monitorLite has two security modes: privileged mode, and user mode.  Activity 
Monitor has only privileged mode (it uses the “pmtool” process running privileged for 
information gathering).  For security conscientious companies or individuals, running 
monitorLite in user mode rather than running Activity Monitor can reduce the number 
of privileged apps being used.

There are a few things which Activity Monitor does which monitorLite does not:

• Take a sample of a running process for debugging purposes.  This is only of use by 
developers.

http://www.graphviz.org
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• Representing processes in a list makes it easy to sort on information like CPU and 
memory usage.  This is the one case were a list view is much better than a graphical 
view and where you will want to turn to Activity Monitor.

• Detailed memory usage information on processes/applications.  monitorLite only 
covers the basics as I don’t believe anyone but developers will truly understand the 
detailed stats.

• Other statistics like “Page Ins”, “Mach Messages”, and “Unix System Calls”: 
monitorLite skips these stats as they tend to only be useful for developers.

So, most of what monitorLite leaves out are of interest to developers and they can continue to 
use Activity Monitor.  I wanted monitorLite to be stream-lined and more useful to non-
developers.  Being able to sort application information on things like CPU usage or memory 
usage is one area where non-developers will still want to use Activity Monitor.  In all other 
cases, I feel the new graphical process view will be more useful to those wanting to better 
understand the inner workings of their computer.

Did you know?
Users of Unix-based systems are aware that you log into the computer under a given userid.  
Under MacOS X, your userid can be tagged to have, or not have, administrator privileges.  
This allows you to use your own password to grant privilege execution status to an application 
or to an action you are taking (i.e. copying an application to the Applications folder).  Running 
an application this way means you are running it in a privileged mode.  In privileged mode, an 
application has the power to do pretty much anything it wants to your system.  That is why 
many people donʼt want to run things in privileged mode unless they really trust it (eg. Apple 
applications).  Further, many worry a buffer overflow defect can render an otherwise 
trustworthy application harmful.

monitorLite can operate in either privileged or user mode letting you decide how much you 
want to trust it.  Note: under user mode, some functionality will not be present.

With the features montorLite offers, I feel it will appeal to two main target areas: education 
and debugging.

Target Audience - Education

I feel that viewing process/application information graphically makes it more natural to 
understand from an educational perspective.  That is why I draw this information as a 
hierarchy on a whiteboard when I am teaching.  Having monitorLite show this information 
graphically in a live window opens the door to using it as a teaching tool:
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1. Institutions:
Teaching institutions will find monitorLite useful for teaching students how computers work 
and for exploring the details of the daemons and processes which run in modern OS’s.  
Having the monitorLite Process Graph projected on a screen will be a more flexible tool 
than static powerpoint slides or laborious whiteboard drawings.

2. Individuals:
Individual users in their homes wishing to learn more about their computer and how it 
works will find using monitorLite for exploring their system a bit easier than Activity Monitor 
or the Unix command “top”.  I find many of my non-developer friends want to learn more 
about how computers work without having to undergo a formal education in computer 
science or engineering.  This is a lot like wanting to know more about how your car engine 
works without becoming a mechanic.  Tools like monitorLite along with the power of 
Google have made such self-learning possible.

Target Audience - Debugging Toolbox

Activity Monitor is advertised as a debugging tool.  monitorLite is no different:

1. IT Specialists:
IT specialists will find monitorLite’s snapshot feature useful for monitoring what is changing 
on servers giving them a “heads-up” of unexpected behaviour (such as a virus daemon 
starting up).

monitorLite also provides a mechanism for IT specialists to document, via a snapshot, 
what is running on a system at a given point in time.  These snapshots can be loaded into 
a tool like Omnigraffe version 5, annotated, then printed creating an audit of a server.  This 
provides history which can be useful in helping to track down when a problem process 
manifested itself.

2. Support Specialists
Many times when I talk with a support specialist on the phone, I really wish they were 
standing next to me watching what is going on.  Screen sharing technologies have made 
this possible, but internet speeds as well as security issues make this impractical.

With a tool like monitorLite available, a user can take a snapshot of what is running on 
their system and send it by email or IM to a support specialist who can use it to assist in 
debugging a problem.  Being able to pause or quit processes from within the monitorLite 
Process Graph makes it useful to track down which process is causing the problems.

3. Individuals:
As the average home user gets more sophisticated and oversees more and more 
computers, a need to acquire some basic IT skills is growing.  Just as monitorLite gives a 
good system monitoring tool to IT specialists, sophisticated home users will find it equally 
useful to use the snapshot feature to see what is changing over time on their systems.
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Usage Details

Installing and Running

monitorLite was packaged to install like most other modern Mac applications:

1. Download the DMG file from the Cadent Computing Inc. website: http://
www.cadentcomputing.com/monitorLite. 

2. Open the DMG and agree to the displayed license agreement (after reading it of 
course).  You can see a copy of the license you agreed to in the last section of this 
document.

3. Drag the monitorLite application to where you would like to run it from.  An alias to 
your Application folder is provided in the disk image window so you can just drag 
monitorLite to it if that is where you want to store it.

4. Eject the DMG image and then double-click on the monitorLite application to run it.

monitorLite has a full featured 30 day trial after which you will be expected to either purchase 
a license for it or uninstall it.  While in the trial period, you will get this dialog each time you 
run monitorLite:

It tells you how many days are left in your trial.  The four buttons do the following:

• Trial - runs monitorLite.  It is full featured and not missing anything due to being in a 
trial.  This button disappears after the 30 day trial has expired.

• Cancel - exits this application.

• Purchase - brings up a dialog for purchasing a license code (see next section for 
details).

• License - brings up a panel to enter license information which has been emailed to 
you.  See next section for more details.

http://www.cadentcomputing.com/monitorLite
http://www.cadentcomputing.com/monitorLite
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Once you have successfully licensed monitorLite, you will not see this dialog again.

License

Once you do decide to purchase a license for monitorLite, click on the “Purchase” button on 
the Trial dialog and you will get this dialog:

This is a dialog from my ecommerce partner, Kagi.  You have three choices:

• Cancel - this takes you back to the Trial dialog.

• Buy Online - this launches a window or tab in your configured browser which takes 
you to the online store at Kagi for Cadent monitorLite.

• Buy Now - this takes you to another dialog panel which allows you purchase a 
license for monitorLite from within the product itself.

As the above dialog indicates, either purchase method uses a secure internet connection to 
Kagi’s servers.  

If you buy online, the following occurs:

1. After filling out the online purchase form, you will be informed by Kagi that an email 
will be sent to you with your license code.  The license code is generated 
automatically so you should receive this email fairly quickly depending on the load 
Kagi’s servers are experiencing.

2. Once you have your email, it will instruct you to bring up the Trial dialog again and 
to click on the “License” button.  This will give you a dialog where you can “copy/
paste” the information the Kagi email to the dialog.
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The License dialog looks like:

These three fields must match the information you provided Kagi (and are in the email sent to 
you).  Clicking “OK” will tell you if the license information is valid or not.

If you choose to buy from within monitorLite, you will get this dialog:
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Fill in this dialog with your personal and credit card information and click on “Purchase”.  You 
will get a progress bar as the information is securely sent to Kagi’s server where it is being 
verified.  On a successful purchase, you will see a dialog like this:

At this point, you license code has been set within monitorLite so you do not have to do 
anything...monitorLite is now fully licensed for you!!!  At any time, if you wish to see your 
license code, select “About Registration...” under the “Help” menu of monitorLite to see a 
dialog showing the currently set registration data.

Please remember to keep your license information secret as it is your property (you bought it).

First Run - Security Level

The first time you run monitorLite, you will be confronted with this dialog:

Answering “Yes” will cause an authorization dialog to be displayed where you have to enter 
an administrator’s username and password (long time Mac users will be very familiar with 
this).  Upon proper authorization, monitorLite will have its privileges updated and it will be re-
launched.  From this moment forward, monitorLite will always run privileged without asking for 
a password.  Remember that: monitorLite will permanently be privileged.  Note: re-installing 
monitorLite will reset the privileged mode and will trigger this dialog again.  That includes 
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trying to copy a privileged monitorLite application to another computer: it will get its privileged 
mode reset.

If you answer  “No” to this dialog, monitorLite will continue to run as is: in user mode.  This will 
reduce the functionality of monitorLite, but will not allow monitorLite to do privileged 
operations, a concern of some security sensitive individuals and organizations.  You can 
trigger the above dialog on a user mode monitorLite again by going under the “File” menu and 
choosing the “ReAuthorize” action.

Overview - Terminology

Before moving to an overview, I would like to introduce/clarify a few terms:

• Process - a process is a unit of execution used by Unix-based systems (and others).  
Applications run as one or more processes as do a lot of system-level “daemons”.  I 
like to think of applications as those things you, the user, launch which have a user 
interface you interact with.  Daemons are created when the system boots up, or when 
you log into your account, and run in the background providing services which do not 
have a typical interface you can interact with.

• Nodes/Edges - nodes and edges are graphing terms.  Nodes in monitorLite are the 
ovals which represent processes in the Process Graph and file descriptors in the File 
Descriptor Graph while the edges are the lines which interconnect the nodes.

Did you know?
Processes run much like the employees in a large company: in a hierarchy.  A process will 
have at most one parent (the process which created it) and can have many children 
(processes it creates).  That is why the Process Graph may look like a very large organization 
chart: this is how things are running in your system.

This has an important implication: if you kill a process, all of its children may get killed with it.  
If they donʼt get killed, they will be orphaned (no, Iʼm not making this terminology up).
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Below is a snapshot of the main window you will be working with when running monitorLite.  
Notice the hierarchical graph with nodes representing processes:

You can see a few unique controls here:

• Refresh - This popup in the toolbar determines how often the all of the graphs and 
dialogs in monitorLite get updated.

• Filters - This grouping of controls determine what the graph is showing you.  These 
are used to isolate those graphical elements of interest.

• Popup Menu - Each of the nodes in the graph have a popup menu with actions you 
can perform on that specific node.  You get this menu by right-clicking (CTRL-clicking  
if single button mouse or trackpad) on the node.

These controls will be covered in more detail in the sections which follow.

FiltersFilters

Popup

Menu

Popup

Menu
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Process Graph

When monitorLite is launched, the first window to be displayed is the Process Graph:

This is a graph showing what proesses/applications are running on your system at this 
moment of time.  The graph will be updated at the frequency set in the Refresh popup in the 
toolbar.  If you are running on an Intel-based Mac, the nodes for those processes running 
under rossetta (PPC-based) will be coloured in brown.  All other nodes start coloured black.  
Nodes can take on other colours based on various events/actions (detailed in other sections 
below).

Note: the topmost node is not a process, but rather represents the entire system.  Double-
clicking on this node will bring up a System Dialog (see below for details).

You cannot drag and drop the nodes/lines in this graph; its layout is done automatically and 
cannot be changed.  monitorLite is not a graphing program.  For that, you can export the 
process graph in DOT format and import it into a graphing program such as OmniGraffe 
version 5 where you can edit it.  This process is described in the section on Snapshots.

The Process Graph is not completely static.  You can double-click on a node to bring up a 
Process Dialog which provides more information on that process.  You can also right-click on 
a node to bring up a set of actions you can perform on that process.

The following sub-sections covers what controls you have on the Process Graph and what 
they do.
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Refresh
This popup in the toolbar allows you to set the graph’s refresh rate as one of: 250 msec, 500 
msec, 1 second, 2, second, 4 second, 10 second, or 1 minute.  The more frequently you 
refresh the graph, the more CPU monitorLite will use.  However, the more often you update 
the graph, the more likely it is that you will “catch” a process which has a very short lifespan.

Important note: the refresh rate here affects all windows and dialogs in monitorLite. So, the 
more often you refresh, and the more windows and dialogs are being displayed, the more 
CPU will be used.

Filters
The Process Graph window has these filters:

• Owned Proc - When checked, processes owned by your userid will be displayed in 
the Process Graph.

• System Proc - When checked, processes owned by the system, or running 
privileged, will be displayed in the Process Graph.

• Other Proc - When checked, all processes not owned by your userid or by the 
system will be displayed.

• Colour Active - This is really not a filter as it does not affect what processes are 
displayed, but rather changes the colours of the nodes based on how much CPU the 
processes used over the last refresh period.  If a process uses less than 0.1% CPU, 
the colour remains black, between 0.1% and 30% CPU the node is coloured green, 
between 31% and 99% the node is coloured orange, and more than 100% the node is  
coloured red.  On all systems, you need to be running monitorLite in privileged mode 
for this checkbox to be present.

Did you know?
Prior to having multi-core CPU systems, a process could not use more than 100% of 
the systemʼs CPU.  Today, however, it can.  Letʼs say you have 4 CPU cores on your 
MacPro.  A process could potentially use 400% CPU if there was a way for it to run 
simultaneously on all four cores.  A process with only one thread (see section on the 
Process Dialog) will only ever be able to use 100% CPU as it can only be running on 
one core at any given moment of time.  But, if a process has more than one thread of 
execution, it can be running on more than one CPU core at any given moment in 
time.  It is this way that a process can consume more than 100% CPU usage and get 
coloured red by monitorLite.

• Search - Entering text into this field and pressing return will cause only those 
processes whose names have the given text in their name to be displayed.  Note: the 
text you enter can be anywhere within the process’s name to qualify and entries are 
case insensitive.  For example, entering “service” in the Search field will cause the 
process “DirectoryService” to be displayed (among others).  The popup box next to 
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the search field will show previous searches and gives a “-- Clear --” option to clear 
the Search field.  Remember to hit return after typing into this field for it to take effect.

• CPU Filter - This filters out those processes which are using less CPU, as a percent, 
than set in this field.  So, if you set 10 in this field, only those processes which are 
using 10% or more CPU will be shown.  You can change this value by using the up/
down arrows, or by just typing a new number into this field.  Remember to press 
return after typing in a new number for it to take effect.  This filter is only present when 
running privileged.

• Mem Filter - This filters out those processes which are using less resident memory, in 
mega-bytes, than set in this field.  So, if you set 100 in this field, only those processes 
which are using 100 MB or more resident memory will be shown.  You can change 
this value by using the up/down arrows, or by just typing a new number into this field.  
Remember to press return after typing in a new number for it to take effect. This filter 
is only present when running privileged.

Un-checking a checkbox hides the corresponding processes.  The way processes are hidden/
revealed is influenced by the “Collapse” View menu item.  See more on that below.  The 
status line at the bottom of the window indicates what filtering is active.  Only when this line 
says “Filters: None” are you seeing all processes.

When you exit out of monitorLite, the current filter settings are stored and re-applied when 
you next restart it.  

Process Popup Menu
When right-clicking on a process, you get a popup menu with these actions (note: those 
actions you are not privileged to do will be ghosted):

• Info - This is the same as double-clicking on the process.  It brings up the Process 
Dialog for that process (see below).

• Open - This opens a new graph window showing the file descriptors being held open 
by the given process.  More details on this are provided in the File Descriptor Graph 
section below.  Note: this option is not available on PPC-based systems when you are 
in user mode.

• Pause - This action will attempt to pause the process thereby stopping it from 
running.  Not all processes will allow themselves to be paused and some may even 
terminate on the attempt to pause them.  When a process is paused, the process’s 
node in the graph will turn an orchid (sort of pink) colour and this action will be 
renamed to “Unpause”.  Selecting “Unpause” will allow the process to run again.
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Did you know?
Pausing processes is a great way to determine if a process is causing problems or to 
stop a CPU hog from slowing everything else down.  When you pause a process, it is 
prevented from running and goes into a “holding” pattern.  Some processes which are 
reliant on a tight time schedule will not appreciate being paused.  Donʼt be surprised if 
they crash after being un-paused.

Note: I do not recommend pausing the Finder process as this will basically lock up 
your system.  There are other processes which may do this as well.  Stick to pausing 
applications you launched yourself unless you know what you are doing.

• Quit - This action attempts to quit the given process.  If that process does not want to 
quit, this action may have no effect.

• Force Quit - This action attempts to force the given process to quit.  This usually 
works as a process should not be able to deny this action. However, if your userid 
does not have the privilege to force quit the given process, it may not work.

Whether you choose to quit or force quit a process, “remember the children”.  Any 
processes below the one you are terminating may be terminated too.

Menu View:Zoom
Under the “View” pulldown menu is a sub-menu called “Zoom”.  In this sub-menu are the 
following options: 10%, 25%, 50%, 75%, 100%, 125%, 150%, 200%, 300%, 400%, and 
500%.  Selecting any of these will change the zoom factor of the currently selected window to 
the given value.

Menu View:Stretch
Under the “View” pulldown menu is a sub-menu called “Stretch”.  In this sub-menu options 
numbered 1-10.  Selecting any of these will change the how much the current graph is 
stretched vertically.  Sometimes things can get a little crowed on a given level in the hierarchy 
causing lines to run over the nodes.  Changing this setting can help to alleviate this.

Menu View:Collapse
This menu item has a check mark on it if it is active and none if it isn’t.  Collapse is on by 
default.

When collapse is on, and you apply a filter, the graph is redrawn as if the filtered-out nodes 
never existed.  They disappear and the other nodes get re-laid out.  In this way, the other 
nodes “collapse” over where the filtered-out nodes were.  Again this is the default behaviour.

If you turn off the collapse view option, filtered-out nodes just don’t get drawn; the other nodes 
stay where they are.  In some scenarios where you want to keep track of some processes but 
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get rid of the ones around them, turning off collapse will stop things from moving around.  In 
general, however, with 80 or more processes, filtering out more than 50% of the processes 
can leave a lot of white space behind so you need to scroll around to find the processes left 
behind.  That is why collapse is on by default.

Process Dialog

The process dialog provides information regarding a given process.  If you are running 
privileged, the Process Dialog looks like this:

However, if you are not privileged, the dialog is much smaller:

Here is a definition of each field:
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Field Description

Command The name given to the process.  Usually matches the name of the 
application which generated the process.

PID The Process IDentifier used by MacOS for that process.

PPID The parent process’s PID (the node above this one in the Process 
Graph).

User The owning user (and userid in brackets).

Threads The number of threads of execution associated with this process.

RSIZE The resident memory size of this process.

VSIZE The virtual memory size of this process.  This number will, most likely, not 
match the one you will see in Apple’s Activity Monitor.  Apple does a lot of 
processing trying to discount shared memory objects from the VSIZE.  I 
did not want to take the same processing hit (it is very big) so I report the 
full VSIZE which means that some of that memory is shared with other 
processes.  I feel this will be ok as long as you know this fact up front.

This dialog updates at the rate set on the Process Graph window.

System Dialog

The top-most node in the graph contains the network name of your computer.  If you double-
click this node, you will get the System Dialog:
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This dialog gives the overall system statistics.  Here is a definition of the fields:

Field Description

System Name The computer’s network name.

User % Percent of CPU being used for user-level process activity over the 
last refresh period.

Sys % Percent of CPU being used for system-level activity over the last 
refresh period.

Idle % Percent of unused CPU over the last refresh period.

Threads Total number of threads running in the system.

Processes Total number of processes running in the system.  This should match 
the number of nodes in the process graph when nothing is filtered 
out.

Mem Free Amount of unused RAM.

Mem Wired Amount of RAM with data “locked” (“wired”) in it.

Mem Active Amount of RAM currently being actively used (not including wired 
memory).

Mem Inactive Amount of RAM inactive but not free.

Mem Used Total RAM being used at this time.

I do not print out the total amount of RAM in your system.  I assume you already know what 
this is.  If not, just add Mem Free and Mem Used.  Adding together Mem Wired, Mem Active, 
and Mem Inactive should be close to Mem Used.

As with all dialogs, this will be updated at the refresh rate set on the Process Graph window.

File Descriptor Graph

When you select to open a process from the process’s popup menu, you will get a new 
window: the process’s File Descriptor Graph.  This window looks and operates much like the 
Process Graph windows does:
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This graph shows the process’s node at the top followed by a series of nodes representing file 
descriptors.  Each file descriptor node has the type of file descriptor it is followed by its file 
descriptor number in brackets.  Only files with associated file descriptors are represented in 
this graph.  Other files such as dynamic libraries used are not shown.

Did you know?
Under Unix-based systems, just about everything is abstracted to a file.  That is why you will 
see below that many things are represented with a file descriptor, not just files.

Double-clicking on any of the file descriptor nodes will open a dialog with more information on 
that file descriptor.  The specific dialog you see is dependent on the type of file descriptor it is 
(more on that later).  

The filters on this graph are:

• Files - When checked, file descriptors representing files will be displayed in the 
graph.

• Sockets - When checked, file descriptors representing sockets will be displayed in 
the graph.

• Other - When checked, file descriptors which represent neither files nor sockets are 
displayed in the graph.

As with the Process Graph, you can change the zoom and stretch settings for the window 
from the View pulldown menu.
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File Descriptor Dialogs

Double-clicking on a File Descriptor node will bring up a dialog depending on the type of file 
descriptor it is.  Each sub-section below covers the different dialogs for each type.

FILE
Under Unix-based systems, a file is something represented on the file system.  That does not 
mean it is a file for storing information, though that is certainly one example.  It can also 
represent a device like a USB port or a random number generator.  If the file is stored under   
“/dev” it represents a device.  

When you double-click on a FILE node, you get this dialog:

In this example, the file is “/dev/null” which is a device used to derive input, or direct output, 
you don’t want (“null” means “void” or nothing).

Did you know?
The first three file descriptor numbers (0, 1, and 2) are pre-ordained by Unix in each 
process to be standard input (stdin), standard output (stdout), and standard error 
(stderr) respectively.  In the above example, stdin has been set to “/dev/null” which 
means it is not receiving any input over stdin.

Also, take note that stderr (and in many cases stdout) has changed from being a FILE 
descriptors under 10.4 to being a PIPE under 10.5.  This is appears to be due to a 
change in the logging system under 10.5.
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The definitions of these fields are:

Field Description

Path The full path to the file on the file system.

Type The type of file this is.  It can be one of the following:

• CHR DEV - A character-based device.
• FIFO - A FIFO IPC file.
• DIR - A directory on the file system.
• BLK DEV - A block-based device.
• FILE - A standard file on the file system.

Access Whether the file is read-only, read-write, or write-only.

Num Links The number of users of this file descriptor.

Size In the case of a real file (and not a device), this is the size of the file in 
bytes.

Offset In the case of a real file, the position we are within the file when reading 
or writing.

SOCKET
Socket file descriptors represent network connections: both internal and external.  Internal 
connections are called “Unix sockets” while external sockets are “IPv4 sockets” for version 4 
internet protocols and “IPv6 sockets” for version 6 internet protocols.  
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Did you know?
Pretty much all of the internet connections you are using today are IPv4.  IPv4 addresses are 
4 numbers from 1 to 255 separated by dots (eg. 127.0.0.1).  They are 4 bytes in size.  That 
means the world has 2(4 * 8) = 232 = over 4.2 billion addresses.  Given that many millions of 
people are using computers (and rapidly growing), there are not enough addresses to go 
around.  Thanks to a technique called “NAT”, we have been able to stretch out the use of this 
address pool, but this is getting more and more difficult as time wears on.

Back in 1996, a potential successor to IPv4 was defined: IPv6.  It brings many changes, but 
the important one of note is that addresses increase in size to 16 bytes.  This creates an 
address pool which will never be exhausted (do the math: 2(16 * 8)).  IPv6 addresses take on 
the form “n:n:n:n:n:n:n:n”.  The dots in IPv4 addresses have been swapped with colons and 
there are 8 numbers rather than 4 and each number is represented as 4 “hexidecimal” digits.  
I wonʼt go into more details here but suggest you seek out more by searching the internet.

Adoption of IPv6 has been very slow (I will give my opinion of this in my blog) but you should 
start seeing IPv6 sockets on your computer soon as MacOS X, and most Unixes, support 
IPv6 and have for over 10 years now.

The dialog for both socket types is:

This example is of a Unix socket.  The definition of each field is:

Field Description

Family The type of socket: Unix, IPv4, or IPv6.
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Field Description

Protocol This is the type of data flowing over this connection.  It can take on 
many values.  Some of the most common ones are: IP, TCP, UDP, and 
ICMP.

Local Addr If this is a Unix socket, this is either “-- Unspecified --” if the socket 
does not rely on the file system, or a file path if there is a file that 
represents this socket.  If this is an IPv4 or IPv6 socket, this is our local 
IP address or “0.0.0.0” (meaning any address we host).

Local Port Unused for Unix sockets.  For IPv4/IPv6, this is the local port this 
connection is using.  If this is a common port, the name is given (i.e. 
“http” for port 80).

Foreign Addr Unused for Unix sockets.  For IPv4/IPv6, this is the domain name and/
or IP address of the machine we are connected to.  If this is 127.0.0.1, 
we are talking to ourselves.

Foreign Port Unused for Unix sockets.  For IPv4/IPv6, this is the port on the other 
machine we are connected to.  If this is blank, this socket must be a 
“listening” socket waiting for new connections. If this is a common port, 
the name is given (i.e. “http” for port 80).

Sock State One or more of these “flags” indicating what state this socket is in:

• CONNECTED - Socket is currently connected.
• CONNECTING - Socket is in the processing of connecting.
• DISCONNECTING - Socket is in the process of disconnecting.
• DISCONNECTED - Socket is now disconnected but has not 

terminated itself yet (must be lingering).
• CANT_SEND - For some reason, this socket is unable to send data.  

Could be present along with DISCONNECTED.
• CANT_RCV - For some reason, this socket is unable to read data.  

Could be present along with DISCONNECTED.
• PRIV - This socket is private (usually just an internal use Unix 

socket).
• NON_BLOCKING - The process opened this socket in a non-

blocking mode (of great importance to developers).
• ASYNC_IO - This socket is being used by the Unix Async IO system 

(a Posix standard, I believe).
• DRAINING - Socket is waiting for its buffers to drain.  Possibly getting 

ready to disconnect or in a disconnecting state.
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Field Description

Tcp State What state this TCP connection is in (blank for any other protocol):

• CLOSED - TCP connection is in a closed state.
• LISTEN - TCP connection is in a listening state.
• SYN STATE - TCP connection has sent a syn packet (part of the 

initial 3-way handshake).
• SYN RECEIVED - TCP connection has received a syn packet from 

the other party (part of the initial 3-way handshake).
• ESTABLISHED - TCP connection has been fully established.
• CLOSE WAIT - TCP connection has initiated a close and is waiting 

for the other side to acknowledge it.
• FIN WAIT 1 - TCP connection is waiting for a FIN packet.
• CLOSING - TCP connection is now closing.
• LASK ACK - TCP connection is waiting for the last ack packet.
• FIN WAIT 2 - TCP connection is waiting for a FIN packet.
• TIME WAIT - TCP connection is waiting for activity and has a timeout 

applied (so it won’t wait forever).

Rcv Buf Sz The size of the receive buffer.  This is the maximum size of the buffer 
and not how much data is in it at this time.

Snd Buf Sz The size of the send buffer. This is the maximum size of the buffer and 
not how much data is in it at this time.

PIPE
Unix pipes are a very simple yet handy inter-process communication (IPC) device.  You will 
see them in very heavy use in many multi-threaded processes.  They can also be used to 
“pipe” input and output between processes.

The pipe dialog is:
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The field definitions are:

Field Description

Status The status of the pipe.

Blocks Allocated The number of blocks allocated by the pipe.

Block Size The size of each block in bytes.

Count The number of items in the pipe.

KQUEUE
A KQueue is a place where a process receives kernel events (kevents).  The dialog 
associated with KQueues is:

The field definitions are:

Field Description

State Current state of the KQueue.  One of: SELECT or SLEEP.

Size The number of items in the KQueue.

FSEVENT
FSEvents are “File System Events”.  The FSEvent file descriptor is where a process can 
receive FSEvents.  The dialog associated with FSEvent is:
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monitorLite does not collect any additional information regarding FSEvents so the above 
dialog is all you will get at this time.

PSHM
This file descriptor represents a Posix Shared Memory block:

The field definitions are:

Field Description

Path This is the name of the shared memory block.  It is usually “obj= 
0xnnnnnnnn” where “0xnnnnnnnn” is a memory address where the 
shared memory block is.

Map Addr This is the offset into the given address where this block is.
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Snapshots

One of the most powerful features monitorLite has to offer is the ability to take a snapshot of 
the process graph.  In addition, you can take certain types of snapshots of File Descriptor 
Graphs.

While the Process Graph window is active, if you click on the File menu, you will see these 
snapshot actions:

• Open Snapshot - This will open a dialog for opening a DOT-based snapshot.  More 
on this later.

• Set Snapshot - This will open a dialog for setting a filename and snapshot type to be 
used by the Snapshot action below.  This setting is remembered by monitorLite even 
if you exit and restart monitorLite.

• Snapshot - This action, which can be invoked by CMD-S, will take an immediate 
snapshot of the Process Graph storing it in the filename and snapshot type defined in 
the “Set Snapshot” action above.

• Snapshot As - This action brings up a dialog which allows you to both set the 
snapshot filename and type, and takes an immediate snapshot.  Subsequent 
Snapshot actions will use this newly set filename.

An example of the Snapshot As dialog is:
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As you can see here, there are four snapshot types:

Type Description

DOT This is a special format designed by AT&T to describe a node/edge 
graph.  There are a handful of packages which support reading/writing 
this format.  This is the only type which can be opened by monitorLite.

JPG The Process Graph is rendered as a jpeg picture.

GIF The Process Graph is rendered as a GIF picture.

SVG The Process Graph is rendered as an SVG vector graphic file.

The three picture-based types of JPG, GIF, and SVG, are meant to be used in other packages 
like Apple’s preview or within a web browser.  This opens the door to printing the graphs, 
something that monitorLite does not currently do.  The SVG type looks great in a web 
browser.

The DOT snapshot type can be opened by third party graphing packages which support the 
DOT format.  Two good examples I use are: graphviz (http://www.graphviz.org) and the Omni 
Group’s OmniGraffe version 5 (http://www.omnigroup.com/applications/omnigraffle/ ).  These 
applications allow you to annotate your process graph, to print it off, etc.

With regards to monitorLite, however, the DOT-based snapshots take on a special capability: 
they let you view differences between when the snapshot was taken, and what is currently 
running.  When you select the Open Snapshot action, you will get a dialog which allows you 
to open a DOT-based snapshot.  This snapshot will open in a new graph window similar to the 
Process Graph window.  This new “Snapshot window” does not have the same filter settings, 
but does have one special checkbox: “Diff Snapshot”.

If you click on this checkbox, both the Process Graph and Snapshot windows will be affected.  
Now, the Process Graph window will only show those processes which are now running that 
were not running when the snapshot was taken.  The Snapshot window will only show those 
processes which are no longer currently running which were running when the snapshot was 
taken.  Here is an example:
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The Process Graph is showing that one process, OmniFocus, has been launched since the 
snapshot was taken.  On the Snapshot Graph, we see 5 processes were running when the 
snapshot was taken but are not running now.

These two windows are active and will change as processes start up and are terminated.  You 
can also interact with the nodes in the Process Graph window as you normally can.  The 
Snapshot Graph nodes, however, are view only.  Note: both windows update based on the 
Process Graph’s refresh rate.  The way the differences are shown is controlled by the 
Collapse View setting for the Process Graph window.

On the whole, this snapshot difference capability opens the door to monitoring changes in a 
system like a server and can, in some cases, catch unusual and unexpected behaviour 
leading to easier debugging by developers and IT professionals. 
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Technical Credits

Almost any software product produced today is not written in a “vacuum” and relies in whole, 
or in part, on the works of other people or organizations.  Here are the works I would like to 
give credit to for their use in creating monitorLite:

wxWidgets
I want to port monitorLite to multiple platforms.  This requires the use of a GUI technology to 
make such a task easier.  I have selected to use a fantastic cross-platform GUI library called 
“wxWidgets”.  This open source project allows programs written in C++ (and other supported 
scripting languages) to be written in a platform-independent way (at least with regards to such 
things as the GUI).

You can learn more about wxWidgets, and get the source code, from: http://
www.wxwidgets.org/ .  For version 1 of monitorLite, I used version 2.8.7 of wxWidgets and 
compiled it statically into the monitorLite binary.  I have not made any modifications to 
wxWidgets.

The license for wxWidgets can be found in the monitorLite DMG in the PDF files: 
“wxWidgetsLicense” and “LGPL_License”.

graphviz dot command
Graphviz is an open source (Common Public License Version 1.0: http://www.graphviz.org/
License.php) graph visualization project from AT&T Research.  Sadly, I discovered graphviz 
very late in my work on monitorLite and I had written a lot of graph representation code 
already.  What I was lacking is the ability to efficiently do graph layouts.  I did not want to 
replace my work with that of the graphviz library, I just wanted the layout stuff.

Here is where graphviz’s “dot” command has come to my rescue.  I have built version 2.16 of 
the dot command for Mac PPC and Intel and put these commands in the monitorLite 
package.  As such, no part of graphviz is present in the actual monitorLite binary (no, not 
even the dot parser, I painstakenly built that on my own..see below), but the dot commands 
are relied upon to generate “xdot” files which hold vital layout information.  I also rely on the 
dot commands to generate various snapshot formats like jpeg, gif, and svg.

Someday, I would like to use the graphviz library itself, but the way graphviz code has been 
built is not compatible with how I have architected my code.

Lemon Parser
Speaking of building a dot and xdot parser, I used my favourite parser tool: Lemon.  I simply 
cannot say enough nice things about how great this parser is!  Lemon is a LALR(1) parser 
generator in the public domain and part of the SQLite project.  You can get Lemon and learn 
more about it at:  http://www.hwaci.com/sw/lemon/ .
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Apple’s “top” Command
The ability to get a list of processes running on a system already exists on all Unix-based 
systems via the “top” command.  It was my intention to use the MacOS X top command as a 
library to get this process list.   This works fine as long as monitorLite is running in privileged 
mode.  It seems that “top” on a Mac makes use of some low-level Mach kernel calls which 
can only be done from a privileged process (Unix-heads: check out the top command on a 
Mac and you will see it is tagged to run as root).

So, I am using Apple’s top when running monitorLite in privilege mode, but had to 
manufacture my own way of getting similar information when running in user mode.  I know 
this is an exercise I won’t have to do on Linux so, as much of a fan I am of the Mac, I was 
quite disappointed in how much more work this caused me.

Apple’s “top” command falls under Apple’s Public Source License.  You can find a copy of it in 
the monitorLite DMG under the PDF file: “Apple - Public Source - License”.

Book: MacOS X Internals by Amit Singh
As much as I have been programming on Unix-based systems for over 20 years, MacOS X 
threw some nasty technical curve balls at me I was not expecting.  I might have given up but 
for an amazing tome written by Amit Singh: MacOS X Internals A Systems Approach (http://
www.osxbook.com/).  If you ever wanted to know more about how MacOS X works, this is a 
book for you.  At over 1640 pages, it is very thorough!
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Support

ScreenCasts

A support web page with screencasts and other help information has been created for 
monitorLite:

http://www.cadentcomputing.com/cadent_monitorlite_help.html

You can also get to this web page by going under the “Help” pulldown menu of monitorLite 
and selecting “Web Help...”.

Support Email

A support email is available if you have a support question:

support@cadentcomputing.com

You can also send an email to this address by filling out the form at:

http://www.cadentcompute.com/support.html

Blog

As I have been doing a lot of education work in the arena of “low-level” computing and 
debugging, I will be maintaining a blog to discuss issues of interest to the users of monitorLite 
and those interested in what other utilities will be following it (foreshadowing...):

http://blog.cadentcomputing.com/

The blog entries will also be replicated in the support forum and it is there that user comments  
will be hosted (the blog itself will not allow for comments).
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License
Cadent monitorLite software

END-USER LICENSE AGREEMENT

PLEASE CAREFULLY READ THIS END-USER LICENSE AGREEMENT ("Agreement") before 
installing this software.  This Agreement is a legal agreement between you and Cadent Computing Inc. 
("Cadent"), the licensor of this software.  By installing this software, you agree to be bound by the 
terms of this Agreement.  If you do not agree to the terms of this Agreement, Cadent is unwilling to 
license this software to you.  Do not download, install, copy or use this software unless you agree to 
be bound by the terms of this Agreement.

Select "Agree" only if you agree to be bound by the terms of this Agreement.
Select "Disagree" if you do not agree to be bound by the terms of this Agreement.

1.  COPYRIGHT.  

This software is owned by Cadent and is protected by copyright laws, international copyright treaties, 
and other intellectual property laws and treaties.  All rights, including copyrights and other intellectual 
property rights, in this software not specifically granted in this Agreement are reserved by Cadent.  
This software is licensed, not sold.

2.  GRANT OF LICENSE.  

(a)  TRIAL LICENSE.  If you are licensing this software for the first time, subject to your compliance 
with the terms of and conditions of this Agreement, Cadent hereby grants you a personal, non-
sublicensable, non-exclusive license (the "Trial License"), to personally use this software for 
evaluation purposes only on a single personal computer, or on multiple computers at different times, 
during a time period expiring 30 days after this software is first installed (the "Trial Period").  You agree 
not to use this software under the Trial License after the Trial Period has expired.  You acknowledge 
that functionality of this software may cease without further notice at any time during the Trial Period 
and you agree that you will not rely on the functionality or performance of this software during the Trial 
Period.  If you wish to continue using this software after the Trial License has expired or use any 
update of this software, you must purchase a license key through an authorized third party supplier of 
license keys for use with this software and its updates (the "License Key Supplier").

(b)  PURCHASED LICENSE.  If you have purchased a license key for use with this software, subject 
to your compliance with the terms of and conditions of this Agreement, Cadent hereby grants you a 
personal, non-sublicensable, non-exclusive license (the "Purchased License"), to personally use this 
software, including any and all software updates made available to you, on a single personal 
computer, or on multiple computers at different times, until the Purchased License is terminated in 
accordance with this Agreement.

3.  RESTRICTIONS.  

(a)  CONCURRENT USE ON MULTIPLE COMPUTERS.  You may not use this software, including any 
software update thereof, under the Trial License, Purchased License or otherwise (collectively, the 
"Cadent monitorLite Software") on multiple computers at the same time or otherwise concurrently, nor 
authorize same.



(b)  TRANSFER.  You may not directly or indirectly transfer all or any portion of your rights under this 
Agreement to any third party.

(c)  RENTAL.  You may not directly or indirectly sell, rent or lease the Cadent monitorLite Software to 
any third party.

(d)  DISTRIBUTION.  You may not directly or indirectly distribute (including, but not limited to, 
distributing by exporting or re-exporting and distributing by posting or otherwise making available in 
any form on the Internet or the World Wide Web) copies of the Cadent monitorLite Software to any 
third parties.

(e)  MODIFICATION.  You may not directly or indirectly reverse engineer, disassemble, decompile or 
translate all or any portion of the Cadent monitorLite Software nor attempt to discover the source code 
or structure of all or a portion of the Cadent monitorLite Software, except to the extent expressly 
permitted by applicable law notwithstanding these restrictions.

(f)  DERIVATIVE.  You may not without written permission from Cadent (i) create or produce any 
derivative work from the Cadent monitorLite Software; (ii) incorporate all or any portion of the Cadent 
monitorLite Software into another software or other work; nor (iii) authorize same, except as expressly 
provided in this Agreement.

(g)  LICENSE KEY.  You may not modify, tamper with, adapt or translate any license key issued for 
use with the Cadent monitorLite Software, nor authorize same.

(h)  OTHER RIGHTS.  You may not violate or otherwise prejudice the title, copyrights, trademark rights 
or other rights of Cadent or any third party by using the Cadent monitorLite Software.  You may not 
use, and may not facilitate others to use, the Cadent monitorLite Software in any manner inconsistent 
with any license agreement of a third party, including any third party provider of the operating system 
on which the Cadent monitorLite Software will execute.

4.  EXCLUSION OF WARRANTY AND LIMITATION OF LIABILITY.  

(a)  You expressly acknowledge and agree that use of the Cadent monitorLite Software is at your sole 
risk.  THE CADENT MONITORLITE SOFTWARE AND ANY ASSOCIATED DOCUMENTATION ARE 
PROVIDED "AS IS" AND WITHOUT WARRANTY OF ANY KIND, EXCEPT AS EXPRESSLY 
PROVIDED BY APPLICABLE LAW NOTWITHSTANDING THIS EXCLUSION.  CADENT AND ITS 
DIRECTORS, OFFICERS, EMPLOYEES, AGENTS, SUPPLIERS AND ANY PARENT COMPANY OR 
SUBSIDIARY OF CADENT (collectively, "Cadent and Affiliates") EXPRESSLY DISCLAIM ALL 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NON-
INFRINGEMENT AND USABILITY OF ALL FUNCTIONS OF THE CADENT MONITORLITE 
SOFTWARE.  CADENT AND AFFILIATES DO NOT WARRANT THAT THE FUNCTIONS CONTAINED 
IN THE CADENT MONITORLITE SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE 
OPERATION OF THE CADENT MONITORLITE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR-FREE, OR THAT DEFECTS IN THE CADENT MONITORLITE SOFTWARE WILL BE 
CORRECTED.  FURTHERMORE, CADENT AND AFFILIATES DOES NOT WARRANT OR MAKE 
ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE 
CADENT MONITORLITE SOFTWARE IN TERMS OF ITS QUALITY, PERFORMANCE, ACCURACY, 
RELIABILITY, OR OTHERWISE.  NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY 
CADENT AND AFFILIATES, OR ANY AUTHORIZED REPRESENTATIVE OF CADENT AND 
AFFILIATES, SHALL CREATE A WARRANTY.  IF THE CADENT MONITORLITE SOFTWARE 
PROVES DEFECTIVE IN ANY WAY, YOU (AND NOT CADENT AND AFFILIATES, OR ANY 
AUTHORIZED REPRESENTATIVES OF CADENT AND AFFILIATES) ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
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(b)  During the Trial Period, you are not under any obligation to purchase a license key.  Under the 
Trial License, Purchased License or otherwise, you may at any time cease to use the Cadent 
monitorLite Software if you are in any way unsatisfied with the quality or performance of the Cadent 
monitorLite Software.  CADENT  AND AFFILIATES SHALL NOT BE LIABLE FOR ANY LOSS OR 
DAMAGES, EITHER DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL OR OTHERWISE, FOR 
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR OTHER THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) 
ARISING FROM THE USE OR INABILITY TO USE THE CADENT MONITORLITE SOFTWARE.  
SUCH DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, DAMAGES FOR LOSS OF PROFITS, 
LOSS OF REVENUE, LOSS OF DATA, LOSS OF USE OF THE CADENT MONITORLITE 
SOFTWARE, AND TEMPORAL INTERRUPTION, EVEN IF CADENT AND AFFILIATES HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN ANY EVENT, THE ENTIRE LIABILITY OF 
CADENT AND  AFFILIATES UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED 
TO THE AMOUNT ACTUALLY PAID FOR THE TRIAL LICENSE ONLY, EVEN IF SUCH REMEDY 
FAILS OF ITS ESSENTIAL PURPOSE.

(c)  Some jurisdictions prohibit or restrict the exclusion or limitation of direct, consequential or 
incidental damages, so the foregoing exclusions or limitations may not apply to you.  Any warranties 
that by law survive the foregoing exclusions or limitations expire at the end of the Trial Period.

5.  YOUR WARRANTY TO CADENT.  You warrant that all individuals having access to the Cadent 
monitorLite Software will observe and perform all the terms and conditions of this Agreement.  You will, 
at your own expense, promptly enforce the restrictions in this Agreement against any person who 
gains access, with your permission or while your employee or under a contract of service to you, to 
any copy of the Cadent monitorLite Software you obtain or lawfully make pursuant to this Agreement, 
and who violates such restrictions, by instituting and diligently pursuing all legal and equitable 
remedies against him or her.  You agree to comply with all applicable internal and national laws and 
regulations, and international treaties that apply to the Cadent monitorLite Software, including but not 
limited to any applicable export regulation of the United States or other country.  YOU AGREE TO 
DEFEND, INDEMNIFY AND HOLD HARMLESS CADENT AND AFFILIATES FROM AND AGAINST 
ANY AND ALL CLAIMS, LIABILITIES, DAMAGES, OBLIGATIONS, COSTS, LOSSES AND 
EXPENSES (INCLUDING BUT NOT LIMITED TO ATTORNEY'S FEES) RESULTING FROM YOUR 
USE OF THE CADENT MONITORLITE SOFTWARE OR YOUR BREACH OF ANY TERM OF THIS 
AGREEMENT.

6.  INCORPORATED WORKS.  

(a)  The Cadent monitorLite Software incorporates without modification all or a portion of a Program as 
defined by the Common Public License version 1.0 (the "CPL v1.0").  Source code for the Program is 
available from or through Cadent upon request by a medium customarily used for software exchange.  
Any provisions of this Agreement that differ from the CPL v1.0 are offered by Cadent alone and not by 
any other contributor of the Program.  You agree that sections 4 and 5 of this Agreement apply on 
behalf of all contributors of the Program.

(b)  The Cadent monitorLite Software incorporates without modification all or a portion of a Library as 
defined by the GNU Library General Public Licence (the "L-GPL").  The Library and its use are 
covered by the L-GPL.   A copy of the L-GPL is reprinted in the documentation accompanying the 
Cadent monitorLite Software, and is available to you from or through Cadent upon request.  The 
complete corresponding machine-readable source code for the Library and the object code of any 
"work that uses the Library" as defined by the L-GPL related to the Cadent monitorLite Software is 
available to you until 3 years after accepting this Agreement so that you can modify the Library and 
then relink to produce a modified executable containing the modified Library.  You agree and 
acknowledge that sections 4 and 5 of this Agreement apply to any such modified executable with the 
same force and effectiveness as they apply to the Cadent monitorLite Software.
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(c)  The Cadent monitorLite Software for some executable versions is a Larger Work as defined by the 
Apple Public Source License version 2.0 (the "Apple License").  For such executable versions, a copy 
of the Apple License is reprinted in the documentation accompanying the Cadent monitorLite 
Software, a copy of the Apple License is available to you from or through Cadent upon request, any 
Additional Terms as defined in the Apple License are offered by Cadent alone, and you agree and 
acknowledge that sections 4 and 5 of this Agreement apply on behalf of Apple and every Contributor 
as defined in the Apple License with the same force and effectiveness as they apply to the Cadent 
monitorLite Software.

7.  CONSENT TO USE OF PERSONAL INFORMATION.  

To purchase a license key from the License Key Supplier, you may be required to provide to the 
License Key Supplier personally identifiable information. You agree that Cadent and Affiliates may 
receive from the License Key Supplier some personal information, including your name and contact 
information, and your license key(s) (the "User Information"), and you agree that Cadent may use the 
User Information primarily to: (i) ensure that you receive your purchased license key(s); (ii) notify you 
of available software updates, except where you have requested not to be notified; and (iii) verify your 
license key prior to providing you with software updates.  Cadent and Affiliates will not receive nor use 
your financial account number nor the expiration date nor the card identification value (CID or CVV2) 
for any credit or debit card you use in purchasing a license key.  You agree and acknowledge that 
Cadent will have no liability to you if any claim is based on the use by the License Key Supplier of 
personally identifiable information.

8.  TERMINATION.  

You may terminate this Agreement at any time.  Without prejudice to any other rights, Cadent may 
terminate this Agreement if you fail to comply with any term or condition of this Agreement.  Upon 
termination for any reason, you must immediately stop using the Cadent monitorLite Software, remove 
the Cadent monitorLite Software from all computers and destroy all copies of the Cadent monitorLite 
Software.  The provisions of sections 1 and 3 to 10 of this Agreement will survive any termination of 
this Agreement.

9.  APPLICABLE LAWS AND VENUE.  

This Agreement will be governed, interpreted and applied in accordance with the laws of the province 
of British Columbia, Canada.  The parties agree to resolve any disputes arising from or in relation to 
this Agreement in the courts of the province of British Columbia, Canada, and any appellate court 
therefrom.

10.  SEVERABILITY.  

If any part of this Agreement is held invalid or unenforceable by a court of competent jurisdiction, the 
remainder of this Agreement will continue to be valid and enforceable to the full extent permitted by 
law.

11.  GENERAL.  

This Agreement is the entire agreement between you and Cadent relating to its subject matter.  This 
Agreement supersedes all prior or contemporaneous oral or written communications, proposals, 
representations and warranties relating to its subject matter.  During its term, this Agreement prevails 
over any conflicting or additional terms relating to its subject matter of any communication between the 
parties.  This Agreement binds the parties' authorized successors and assignees.  No party's failure to 
enforce any provision of this Agreement will in any way affect, limit or waive that party's right or 
obligation thereafter to enforce the provisions of this Agreement.  No modification of this Agreement is 
effective unless in writing and signed by both parties.
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